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As you are probably aware, the
traditional technology for
manufacturing lead shot involves
dropping blobs of lead from
significant heights such that, as the
lead cools during its descent, it
forms perfect spherical balls ….

This tutorial introduces the concepts and techniques used to build 3D models in
AutoCAD 2000. As a vehicle for learning these techniques, we develop a model
of a whimsical structure that I have called the Monkish Shot Tower after a group
of imaginary Monks who have refined the technology of manufacturing lead shot
for firearms, and the like. The tower is designed around the perfect number 7,
features an external spiral stair, an elaborate canopy on top, and a hole down
the centre. The final structure is illustrated in Figure 1 below.
This tutorial will introduce the following concepts and techniques:
• simple solid modelling with solid primitives & CSG operations (the tower);
• construction of complex solid objects (stair and landing);
• user coordinate systems and positioning of objects (external stairs);
• advanced use of the CSG operations (tapering the stairs);
• simple surface modelling (the roof canopy and handrails);
• surface modelling versus solid modelling (the handrails);
• meshed surfaces (the landing “sails” for shading).

Figure 1

1

Four Perspective Views of the Monkish Shot Tower
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GETTING STARTED
As with every drawing that you produce with AutoCAD you should begin by
establishing your drawing area by setting the Drawing Limits, Units and using
Zoom All to expand out to a full view of your drawing area. Do that now, setting
the limits to 20000 x 15000.

Layer Control button
Hint:
To create a new layer in this
dialogue box, simply click the New
button and type a name for the
layer in the list. To set the colour,
click on the colour box adjacent to
the corresponding layer.

For this model, we will make use of several different layers for handling different
parts of the model. Begin by calling up the Layer Control dialogue box (see
button at left) and create two new layers called “Construction” and “Tower”,
setting each to a different colour (I used green and white respectively). The
Construction layer will be used for construction lines that do not form part of the
final drawing. The Tower layer will contain the central tower.
The last thing to do before beginning the tower is to create a single reference
point for this model … we will do this by placing a Point entity on the
Construction layer at the centre of the drawing area (which will become the
centre of the base of the Shot Tower). We will be using Points a few times in
this drawing as reference markers, so we need to set a Point Style that will be
easily visible (the normal way AutoCAD marks a point is with a single dot … we
will use an X-shaped cross instead). To do all that, proceed as follows …
Begin by setting the current layer to Construction — pull-down the list of layers
(illustrated at left) and click on Construction … then proceed as follows …

Pull-down layer list …

Draw point tool …

Format >
Point Style

Select from the pull-down menus — in the resulting
dialogue box select the X-shaped cross and then click OK.

[Draw.Point]

Issue the Point command (illustrated) and click a position
at about the centre of the drawing area …

<Esc>

To cancel the command.

CONSTRUCTING THE CENTRAL TOWER
In keeping with the principle that everything in this Shot Tower is designed
around the perfect number 7, we will construct a 7-sided polygonal tower, 19.6
metres high (7 levels at 2700), with an outside diameter of 7 metres, and
o
tapering inwards at a gradient of 1:70 (which converts to an angle of 1.3 off the
vertical). Proceed as follows:
Set the current layer to Tower …

Polygon tool

Offset tool

[Draw.Polygon]

Select from the Draw Toolbar.

7↵

Number of sides — then use the |NODe| object snap mode
to fix the centre at the point entity just created.

i↵

Specify an inscribed polygon.

3500 ↵

Radius of the polygon.

[Modify.Offset]

Issue the Offset command (as illustrated).

300 ↵

Offset distance — select the polygon just drawn and then
point to the inside to show the side to offset — press ↵ to
complete the command.

We now have to extrude these two polygons in the Z-direction to the height
required, specifying the 1 in 7 taper as we do so. We will then subtract the inner

2

Updated: May 2000

AutoCAD 2000 in 3D - A Monkish Shot Tower

one away from the outer one to create a polygonal shell with an empty interior.
Once we have done that, we will position a box to serve as the doorway at
ground level and subtract that away from the shell to create the opening. That
will complete the basic tower! To do all that, proceed as follows …
View >
Toolbars

Open the Toolbars dialogue box, scroll down the list to find
the Solids toolbar, and then click on the check-box next to
it. Position it anywhere convenient on the screen, taking a
moment to examine each tool, and noting the brief
description of each on the status line as you move the
mouse across them..

[Solids.Extrude]

Pick the Extrude command (as illustrated) — don’t forget to
watch the prompts on the command line so that you
understand the process! — select both polygons and then
press ↵ to complete the selection.

19600 ↵

Height of each extrusion.

1.3 ↵

Taper angle.

Solids Toolbar with the Extrude
command highlighted ..
Solid Modelling:
With solid modelling we sculpture
objects by assembling the
primitives shown on this toolbar
using the three CSG operations of
Union, Difference (subtract) and
Interesection. As you will discover
in this tutorial, there is almost
nothing that cannot be formed
using these tools.

To see the effect of this in 3D, select View > 3D Views > SE Isometric from the
pull-down menus … this will create a parallel projection (not a perspective) of
the 3D object looking from the +X / -Y quadrant. You can then use the normal
Pan and Zoom commands to alter the screen display to suit you own purposes,
while maintaining that parallel projection. Experiment with this until you have a
3D view of the whole tower near the centre of your drawing area.
The CSG tools are located on the Solids Editing Toolbar (illustrated). You can
keep this on the screen or you may feel it is easier to execute these commands
through the pull-down menus …
Modify > Solids
Editing >
Subtract

Issue the Subtract command — note that this command
allows you to select two sets of objects: the second set are
then subtracted from the first — we will have only one
object in each set in our case — select the outer shape
and press ↵ (the “primary” object), and then select the
inner object and press ↵ again (the object to be subtracted
from the “primary” one) — don’t forget to watch the
prompts to understand how this works.

hide ↵

Issue the Hide command — this draws the current view
with all hidden lines removed or truncated as necessary —
notice that your tower is now one single solid object which
is hollow down the centre.

Solids Editing Toolbar

Real-Time Pan & Zoom

These new tools are great for
moving around your drawing …
hold down the left button while
dragging the mouse up and down.
User Coordinate System (UCS):
This is a 3D cartesian coordinate
system that operates independently
of AutoCAD’s fixed World
Coordinate System (WCS). It can
be positioned and orientated
anywhere in space (at any angle).
All 2D drawing is always done in
the UCS X-Y plane: normally, the
UCS is coincident with the WCS!
This means that you can use all the
2D drawing commands that you are
used to, only place them anywhere
in space by first positioning the
UCS. This would allow you, for
example, to draw a cross-hatch
pattern on a sloping roof plane!
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The next step is to punch a doorway through the base of the tower. Begin by
zooming in to the base of the tower with a view similar to that shown in Figure 2,
over the page (Hint: use the new real-time pan and zoom tools in the standard
toolbar). To make this process simpler, we will position the UCS (see
explanation at left) as illustrated (Figure 2), with the origin at the outside corner
of the tower and the X-axis in line with its base. To do that, follow these steps:
ucs ↵

Issue the UCS command to alter the position of the current
UCS — notice the command prompt, showing options for
saving and restoring UCS settings.

n↵

Select the New option … notice the variety of ways that
you can define the UCS … we will use many of these in the
course of this tutorial …
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Re-oriented UCS icon …
NOTE: if the UCS icon has been
placed at the origin (point 1 in
Figure 2), then type the command
ucsicon ↵ and then type n ↵ for
“No Origin” .. that will force the icon
back to the lower left corner of the
screen

3↵

Select the 3point option keyword — this is the most
versatile option, allowing us to define the new UCS
precisely — watching the prompts, proceed as follows …

|ENDpoint|

Use the object snap to put the origin at 1 .

|ENDpoint|

Use object snap again to identify a “point on the X-axis” at
2.

|ENDpoint|

And again, to nominate a point on the “positive Y portion of
the XY plane” at 3

Notice that the UCS Icon has
now dropped the “W” (no
longer World Coordinates) and
has been positioned at the new
origin, oriented to suit the new
UCS. See note at left to move
the icon back to the lower left
corner of the screen. We now
use the Box primitive to
construct the doorway … be
careful that you use the “corner
box” rather than the “centre
box” …

"
#

$
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Figure 2 Constructing the Door Opening at
the base of the Tower

[Solids.Box]

Select from the Solids toolbar — AutoCAD will prompt for
the corner position of the box …

|ENDpoint|

Use the object snap mode to place the corner of the box at
1 in Figure 2.

@1400,500,
2100 ↵

Specify the opposite corner of the box as a relative 3D
coordinate — alternatively, this could have been done by
entering the length, width and height of the box separately.

[Modify.Move]

Issue the normal Move command — select the box just
created and press ↵ — set the Base Point at the |MIDpoint|
position marked 4 (on the box just created) and the
Second Point at the |MIDpoint| of line 1 - 2

[Modify.Move]

Re-issue the Move command — select the same object
and press ↵ and pick any point as the Base Point …

@0,-100 ↵

Specify the Second Point of the displacement to move the
box so that it is centred on the thickness of the wall.

Modify > Solids
Editing >
Subtract

Issue the Solids Subtract command – pick the tower first
and then press ↵, then pick the box and press ↵ again —
you should now have a door opening in the base of the
tower!

Box tool in the Solids Toolbar.

Move tool

Notice that we deliberately made the box wider than the wall’s thickness (500
instead of 300) so that when it was positioned, it protruded from both sides of
the wall … this is especially necessary in this case since the tower is tapered
and the wall leans in slightly. Generally, however, when performing this
type of operation, it is prudent to always oversize the subtracted object
to ensure that no thin slivers of material are left behind! If you try to be
too precise, you can encounter precision errors.
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CONSTRUCTING THE EXTERNAL WINDING STAIR
Discussion …

The decision to taper the tower inwards was deliberate because it leads to some
interesting complications in this otherwise simple model. The first of those
complications occurs with the stairs since they too have to taper inwards as they
climb the tower. We get over this complication very simply. We begin by
building the stairs straight up with no taper, each flight hugging the face of an
imaginary extrusion (downwards) of the 7-sided polygon that forms the inside
edge of the (tapered) top of the tower: this means that at the base of the tower
the stairs actually lie partially inside the tower. Once the stairs are complete, we
will create another tapered tower in the middle of the stairs and subtract that
away from them to create the internal taper — the stairs will then very neatly
follow the face of the real tower. We then do the same with the outside taper:
we build the flights very wide to begin with, and then at the end of the process
we construct a large tapered tower with very thick walls which we can also
subtract away from the stairs, thus creating the outer taper. This process is
illustrated in Figure 12. Producing the taper is easy: the harder part is
constructing the stairs to begin with …
First, we need a few construction lines —
• make the Construction layer the current layer again,
• reset the UCS back to “World” (issue the UCS command and then press ↵ to
accept the default “World”),
• and Zoom out to a view that allows you to see the top of the Tower.
We begin by tracing the inner edge of the top of the tower … to do that, we
switch on running object snap …

Drafting Settings dialogue …
With Running Object Snap turned
on, whenever you are using the
mouse to select a point, AutoCAD
will highlight and identify the
nearest snap point within the snap
aperture … to use that snap point
simply click the mouse button … if
the snap is ambiguous, pressing
the Tab key will cycle through the
available snaps at that point.

Tools >
Drafting
Settings

Call up the Drafting Settings Dialogue box with the Object
Snap tab (as illustrated) … I suggest that you select each
of the ones shown in the illustration at left … note the brief
explanation of how to use these if you have not done so
before …

[Draw.
Polyline]

Issue the Polyline command — pick each of the 7 vertices
around the inside edge of the top of the tower …

c↵

Close the polyline.

[Modify.Move]

Use a Window selection rectangle to select the polyline just
drawn (you work out why!) and then press ↵ — set the
Base Point anywhere you wish (well away from everything
to avoid the running object snap) …

@0,0,-19600 ↵

Second point of the displacement vector.

Re-position your view to the bottom of the Tower, then, with ORTHO mode
turned on (click the ORTHO button on the status line), construct two parallel
lines of roughly the same length (as illustrated in Figure 3) projecting out from
adjacent corners of the polygon just constructed.
Now choose View > 3D Views > Plan View > World UCS and then zoom in on
the ends of those two lines — we will use these lines to set out the stairs in
profile as illustrated in Figure 4 (over the page).
Figure 3

5

[Draw.Line]

Issue the Line command — pick the start point at the
bottom end of the rightmost line.

@0,140 ↵

Height of riser (multiple of 7!!!).

@-280,0 ↵

Length of going (another multiple of 7!!!).
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↵

to terminate the Line command.

[Modify.Copy]

Use Window selection to select both the riser and the
going lines — press ↵ to complete the selection …

m↵

Select the Multiple option … with using ENDpoint
AutoSnap, set the Base Point to the base of the riser line
— then place each copy at the left end of each successive
going line to form the stair flight — stop just before you
reach the second construction line by pressing ↵

[Draw.Line]

Use the Line command (still with ENDpoint AutoSnap) to
construct a line joining the bottom of the nosing to the top
riser with the bottom of the nosing to the lowest riser.

[Modify.Offset]

Offset the line just constructed down by 140 to form the
soffit of the stair flight …

[Draw.Line]

With ORTHO on, draw a short line from the ENDpoint of
the bottom end of the lowest riser back in the Y-direction …

[Modify.Erase]

Erase the right-most original construction line and the line
that was offset to produce the soffit line … you should end
up with something that looks like Figure 5 ..

Figure 4

Figure 5

Using Figures 5 & 4 as a guides (before and after!), use the Fillet command
(with radius 0) to clean up the stair profile by joining up each of the corners.
Next, we use the polyline edit command to convert the stair profile into a single
polyline entity as follows …

Pedit tool (in the Modify II toolbar)

Modify >
Polyline

Issue the Polyline Edit command … select ANY ONE of the
lines that make up the stair profile — AutoCAD will note
that it is not a polyline, but will offer to convert it into one
(see the Command line) — press ↵ to say “yes” …

j↵

Select the Join option — then use Window selection to pick
all the lines that make up the stair profile (it doesn’t matter
that one has been selected twice!) — press ↵ to complete
the selection — AutoCAD will then join all those lines to
form one polyline …

↵

Press ↵ to terminate the command.

Now turn off the Tower layer, then create a new layer called Stair (making
it a distinctive colour) and set it as the Current Layer before proceeding.
Next, use the Solid Extrude command to extrude the polyline to a height of 2500
to form the width of these stairs and then set up a 3D view a little like the one
shown in Figure 6 (Hint: the SE Isometric view and then Zoom Window gave
me a good view). The next step is to rotate the stair into an upright position …

Z
Y
X

$

Figure 6

Right Hand Rule:
If you hold your right hand with your
thumb pointing in the positive
direction along the axis of rotation,
then your fingers point in the
direction of positive rotation
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Modify >
Issue the Rotate 3D command — select the stair and press
3D Operation > ↵ to complete the selection …
Rotate 3D
x↵

Select the X-axis option (to rotate the stair around that
axis) — use |ENDpoint| to set the axis through the point 1
shown in Figure 6 …

90 ↵

Rotation angle follows the Right-Hand-Rule … see
explanation at left

Updated: May 2000

AutoCAD 2000 in 3D - A Monkish Shot Tower

[Modify.Move]

Using |ENDpoint|, move the stair using the centre of
rotation point as the Base Point and the point on the
“construction polygon” as shown in Figure 7 as the Second
Point of displacement.

The next step is to copy and then rotate this flight to create the second flight of
stairs. We then need to form the landing between them, then we can duplicate
the stair all the way up the tower, and finally union all the parts together to form
a single spiral stair. Sound easy?

Figure 7

Begin by selecting a NE Isometric view & zoom in the view shown in Figure 8.

#
$

"

[Modify.Copy]

Select the stair flight and press ↵ — pick the Base Point 1
and Second Point of displacement 2 as shown in Figure 8,
using the |ENDpoint| object snap mode.

[Modify.
2D Rotate

We deliberately use 2D rotate because we only want to
rotate horizontally — again, pick the stair flight that we wish
to rotate and press ↵ — following Figure 8 closely, set the
centre of rotation (called the “Basepoint”) to point 2 …

r↵

When prompted for the rotation angle, choose the
Reference option because we want to “point” to the angle
of rotation (rather than calculate it, especially as it is a
rather odd number) — still using |ENDpoint|, pick points 2
and 3 as the “reference angle” — for the “new angle”, we
want to use the X & Y value (only) of the point marked 4
taking its Z-value from point 2 — to do that, proceed as
follows …

.xy ↵

This is called a Point Filter (AutoCAD will only take the XY
value of the next point and then prompt you for the Z-value)
— pick the point marked 4 — finally pick the point marked
2 still using |ENDpoint|).

!

Figure 8

Now is a good time to learn another way of setting up a 3D view … we want to
position ourselves to look down at the gap where we need to construct the
landing. Select View > 3D Views > Viewpoint Presets … you should get the
adjacent dialogue box on the screen. The left diagram shows the plan viewing
angle (with the small line pointing towards the centre showing the line of sight in
plan — this is set to NE at the moment) and the right diagram shows the altitude
(again, with a small line to show the current line of sight in elevation — 45
degrees). You can re-position the line of sight on either diagram simply by
clicking with the mouse. Experiment until you get a view similar to that shown in
Figure 9 (over the page), remembering that this is still just a parallel projection.
Viewpoint Presets dialogue …
This dialogue is most easily called
up by simply typing vp ↵.

BLIPMODE
In case you have forgotten …
“blips” are those small marks that
AutoCAD places wherever you pick
a point on your drawing … they can
be turned ON or OFF at will by
selecting Tools > Drawing Aids
and clicking the corresponding
checkbox.
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A Couple of Helpful Hints …
Now that the model is beginning to get a little complicated, you need to be
warned that Object Snapping in 3D is a little error-prone at times (although
the current version is vastly improved in this regard) … AutoCAD will
sometimes snap to the wrong point for seemingly inexplicable reasons.
When that happens, you should not despair — simply cancel the command
and start it again, the second time zooming in on the areas concerned so
that your pick points can be entirely unambiguous. It is often a good idea to
have BLIPMODE on (it is normally OFF) because the small “blips” tell you if
AutoCAD snapped to the correct point. Remember also that with |ENDpoint|
snaps, you don’t need to be right near the end of the entity — you can often
find an unambiguous point to pick that is away from the end, but still less
than halfway along the length of the line or arc!
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You should know all the commands necessary to construct the landing, so I will
simply describe the steps that you should follow:
• the first thing to do is set the UCS onto the plane of the landing — that is
easily done using the 3Point option in the UCS command (refer to the
illustration on page 9) and placing the origin at 1 in Figure 9, the X-axis point
at 2 , and the third point (on the XY plane) at 3 ;

#
"

$

• next, set the current layer to Construction;
• construct a short line beginning at 1 and extending to @0,1000;

Figure 9

• construct another line beginning at 1 and ending perpendicular to line 3 - 2 ,
and then move that line so that it ends at 3 ;
• Fillet the two lines just drawn to form the outside edge of the landing;
• construct a polyline that joins points 1 , 2 and 3 and then join that to the first
two lines to form a single closed polyline around the landing;
• set the Current Layer to Stair;
• finally, use Solid Extrude to form the landing slab, but when prompted for the
height pick point 1 (zoom in if necessary and use |ENDpoint|) and then the
point immediately below it on the underside of the stair flight (using
|ENDpoint| again) to SHOW the depth rather than enter a number.
Your slab was probably extruded upwards (like mine) … simply use the
Move command to move it back down to where it belongs.
We now have to fill in the gap below the bottom tread of the second flight and
the edge of the landing we just created. Using Figure 10 as a guide, follow
these simple steps:

"
$
%

#

• set the Current Layer back to Construction;
• position the UCS with origin at 1 , X-axis point at 2 and YX plane passing
through 3 ;

!

• construct a line beginning at 4 and extending back up the slope to around
point 5 using the |NEArest| object snap — then move that line so that it
extends down from position 4 (as shown in the figure);

Finished
shape ..

• construct the other three lines to form the finished shape as illustrated, fillet
them and use the Polyline Edit command to join them together to form a
single polyline;

Figure 10

• set the Current Layer to Stair, and use Solid Extrude with a height of -2500 to
form the required solid.
Once that is complete, use Solid Union command (Modify > Solids Editing >
Union) to merge the second flight, the landing and the section under the bottom
tread into one solid object. Do not include the original flight in the union!!

#
$
!

"

Figure 11
Note:
This whole process of copying and
rotating the stair flights to form the
whole stair involves a lot of
zooming and panning … once you
have completed that process, you
should feel more competent about
manipulating objects in 3D space.
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Now set up a view similar to that shown in Figure 11. Reset the UCS back to
World, and using the Copy command, pick up the second flight and position the
copy using positions 1 and 2 as the Base Point and Second Point respectively.
Then, use 2D Rotate to rotate the copy around the position marked 2 and then
use the Reference option to show the angle, snapping to points 2 , 3 and 4 in
that order.
Now repeat that process, this time copying both flights 2 & 3 together to become
flights 4 & 5. You can then copy those four flights in one action to create flights
6 through 9. You can almost complete the entire stair by copying those 8 flights
to form flights 10 through 17. You will then find that you need to copy the top
flight (only) one last time to complete the stair.
Just to see the effect, turn on the Tower layer and then use View > 3D Views >
Front to see the Tower in elevation view … you will see the stairs projecting
above the tower. Don’t worry about that … we’ll fix it up later.
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The final step to complete the stairs is to union all the separate flights together
and then trim away the sections that are not needed. With Stairs as the Current
Layer, turn off each other layer (click on the “light globe” symbol in the pull-down
Layer Control tool). Then issue the Solid Union command, select all the stair
entities and press ↵. Turn the Construction layer back on, but keep Stairs as
the Current Layer.

Figure 12

Now set up a 3D view that enables you to see the base of the tower and the foot
of the stairs at the largest possible scale. Construct three 7-sided polygons,
centred at the Point entity at the centre of the tower, all Inscribed, and with radii
of 3510 (10 mm larger than our tower base), 4700 (1200 larger than the base of
the tower to be the width of the stairs), and 7000 (being much larger than the
outside of the stairs). Extrude each of these polygons to a height of 25000 with
a 1.3 degree taper. Next, subtract the middle one (with radius 4700) from the
outer one so that we have an outer ring, a middle core and the stair bridging
between the two as illustrated in Figure 12. Finally, simply subtract both the
outer ring and the middle core away from the stair object to create the tapered
stair. Now turn the Tower layer back on and admire what you have achieved so
far!

BUILDING THE PLATFORM
Before going on to the next stage to construct the platform at the top of the
tower, I want to take a couple of minutes to introduce the other tool that can be
used to select 3D parallel views of your model. This tool is called up by
selecting View > 3D Views > VPOINT (or using the command vpoint ↵)and
results in a display illustrated in the left margin. This is the original method
provided with AutoCAD for setting up quick views — the Viewpoint Presets
dialogue was introduced with Release 12 and is probably a bit easier to use.

3D View Tripod ..

NOTE ON UCS:
The major UCS tools are
contained in a flyout on
the Standard Toolbar …
you will use these a lot in
this tutorial …
Previous UCS

To use the Tripod, imagine the object in the top right to be a flattened globe of
the world viewed from above. Position the mouse pointer near the very centre
point — this is the “north pole” and creates a view looking down the Z-axis (see
the axes in the centre of the screen). As you move out toward the inner ring,
you are moving toward the “equator”, and as you move around within that inner
ring, you are moving around and above the object (again, watch the axes
change as you move around). The outer ring represents the south pole (rather
flattened out!). As you move about between the inner and outer rings, you are
looking up from underneath the XY plane. If you move outside the outer ring,
then the view is meaningless.
Experiment with the tripod to move around and examine the model so far.
When you are ready to proceed, turn all layers on and zoom in on the base of
the tower so that you can see the original reference point we created.

World UCS
Object UCS

[Modify.Copy]

Select the original reference point entity, press ↵ to
complete the selection, and then pick a Base Point
anywhere.

@0,0,19600 ↵

Relative vector to place a copy of the reference point at the
top of the tower.

Face UCS
View UCS
Origin UCS
Z-Axis UCS
3 Point UCS
Rotate UCS about X
Rotate UCS about Y
Rotate UCS about Z

Now change your view so that you are looking down onto the top of the tower.
You will have noticed that the last flight of stairs extends above the top of the
tower! Since we are now going to work up here for a while, it makes sense to
move the UCS onto the plane of the top of the tower …using the UCS flyout
illustrated at the left, click on Origin UCS and then use the |NODe| snap mode
to pick the reference point at the top of the tower. The axes are now orientated
the same way as the WCS, but the origin has been moved.

Apply UCS
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The procedure necessary to construct the platform involves commands with
which you should already be familiar, so I will simply list the steps you should
follow:
• Set the Current Layer to Stair, and construct a large cylinder, centred at the
new origin, and large enough to fully enclose the top of the stair (say, 6000
radius and 10000 high) — subtract that away from the stair to truncate the
top flight level with the top of the tower.
• Create a new layer called Platform and make it the Current Layer.
• Construct a cylinder centred at the origin, 6000 radius and 140 high.
The next step is to cut a hole in the platform above the stairs … you can see
that illustrated in Figure 1 where the stairs reach the top of the tower.
• Set the Current Layer to Construction and, using Figure 13 as a guide,
construct a 7-sided polygon centred at the origin 1 with an inscribed radius
set by using the .xy point filter with |ENDpoint| and picking the outer-most
point 2 on the top-most landing of the stair (and then picking any point on the
XY plane of the UCS to specify the Z-value).

#

$
Figure 13
NOTE: To save you looking back
over the notes, the steps are 140
high with a 280 tread width …

• Switch back to the Platform layer and use that polygon, along with the
outside edge of the top of the tower, to construct a polyline around the
opening that needs to be created above the head of the stair — use Figure 1
to see roughly where I placed the opening — you can size yours how you
like, provided you allow enough headroom over the stairs! (Hint: you need
about 15 risers to create enough headroom: that is, the short top flight, the
full flight below that, and the first few steps of the flight below that.)
• Extrude the polyline up to height of 200 and move it down by about 20 so that
it protrudes both above and below the platform slab (remember the earlier
comment about avoiding thin slivers of material?), and then subtract it away
from the platform slab.
• Finally, cut a circular hole about 2000 in diameter at the centre of the
platform slab (through which the blobs of molten lead would be dropped!).

Don’t forget to save your
model since we have just
completed a fairly lengthy section!!

That about does it for the platform … in the next section you will learn how to do
some simple surface modelling.

SURFACE MODELLING - COLUMNS, PLATFORM HANDRAILS AND ROOF
Surface Modelling
In surface modelling, all objects are
represented by sets of connected
planar surface patches, usually
each defined by 3 or 4 edges.
These patches are, of course,
opaque. In AutoCAD, the patches
are represented by an entity called
a 3Dface.
3Dfaces can be constructed
separately, but more commonly are
created as part of either a primitive
or a mesh. Thus AutoCAD has
commands to construct simple
surface primitives (like boxes,
cones, spheres, wedges, etc.). It
also has four commands that
create complex surface meshes
that don’t actually enclose volume
in the way that the primitives do:
ruled surfaces, tabulated surfaces,
surfaces of revolution and edge
surfaces. We will use three of
these in our model!
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We choose now to construct the columns and handrails that enclose the
platform as surface objects (called meshes). They could be constructed as
solids just as easily, but the way AutoCAD represents curved solids tips the
balance in favour of surfaces. To get a feel for that, do a “hide” looking at the
platform you just created — notice that the curved edge is triangulated, which
would look a bit strange on a round column or handrail. To cancel the hide, use
the Regen command.
A brief comment on strategy at this point: because the columns and handrails
are very repetitive, we will create one column with two pieces of handrail
attached to it, save that as a block and then simply insert instances of that block
all around the platform. That will conserve memory space since the complex
geometry is only being stored once, but being used around 20 times.
It would be appropriate now to close the Solids toolbar and open the
Surface toolbar instead.
Begin by moving the UCS origin up by 140 to the top of the platform slab (but
keeping it at the centre). Then create a new layer called PlatformColumns, set
the Current Layer to Construction, and freeze all the other layers except
Platform, Construction and PlatformColumns (so that they are invisible & ignored
by AutoCAD).
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We will model the columns as a tabulated surface mesh. These are meshes
that are created by projecting (or extruding) a curved entity (referred to as the
path) along a direction vector. In our case, the path will be a circle in the plane
of the platform, and the direction vector will be a line up the centre of the column
(see Figure 14). Note that the direction vector must be a simple line, but does
not have to be perpendicular to the plane of the path. Equally, the path does not
have to be closed for a tabulated surface mesh. Ours is actually a very simple
application of a tabulated surface!
The curved handrail segments will be modelled as surfaces of revolution. These
take a generating “path” (in our case it will be a circle) and sweep it through an
arc (up to 360 degrees) around an axis. We will use a vertical axis positioned at
the centre of the platform (as illustrated in Figure 14 at left). As with the
tabulated surface mesh, the generating path does not have to be closed — as
you will see later, the canopy roof over this platform is also created as a surface
of revolution using an open polyline as the path.
We need to begin by drawing some construction lines (illustrated in Figure 15
over the page):
Figure 14
(This is a view of the completed
handrails and columns to give
some idea of where we are
heading.)

• Draw the axis line from the centre top of the platform (should be the origin of
the current UCS) straight up to a height of around 4000.
• Draw a circle, centred at the base of the axis line with a radius of 5850.
• Draw another circle centred at the “west quadrant” point of that larger circle,
with a radius of 100 — use the |QUAdrant| snap mode and pick the large
circle near where it intersects the negative-X UCS axis.
• Draw a line (to become a direction vector), beginning at that same quadrant
point, and extending straight up (Z-direction) to a height of 2700 (the height
of our columns).
• Draw another line beginning at that quadrant point and extending 1000 in the
Y-direction (@0,1000,0).
• Move the last line drawn up in the Z-direction by 450 — we will use it to
construct the lower handrail.
• We now want to temporarily re-position the UCS so that its Z-axis follows the
small line we just created — use the ZAxis option in the UCS command (see
page 9) and, using |ENDpoint| place the UCS origin at the start of that line
and the “point on the Z-axis” at the other end.
• Issue the Circle command, specifying the centre as 0,0 and the radius as 20
— a small circle should appear on the columns axis 450 above the floor and
“facing” along the direction of the edge of the platform (see Figure 15).
• Reset the UCS back to its previous position (using the Previous option!).
• Copy the small circle up 450 for the top handrail.
That completes all the construction lines that we need — zoom in to a view that
looks like that shown in Figure 15.

Figure 15

Set the Current Layer to PlatformColumns. We’ll draw the handrails first …
[Surfaces.
Revolved
Surface]

Issue the command from the Surfaces toolbar (illustrated)
— select one of the “handrail” circles, and then pick the
axis line ( at the centre of the platform) near its lower end
(zooming out if necessary)…

↵

Accept the default start angle.

–20 ↵

Specify the End Angle as a negative number because we
want to form the handrails in a clockwise direction.

Revolved Surface tool
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Repeat the process for the second handrail. Zoom in on one of the handrails
and notice how the facets have been formed. Normally, AutoCAD constructs 6
facets in each direction … is that what happened here?
With the columns, it would be nice if they were constructed with more than 6
facets. To control the number of facets used, we set the value of an internal
variable called SURFTAB1 for the “first” mesh direction and SURFTAB2 for the
second. Since the column mesh is uni-directional (one-way curvature), we only
need to change SURFTAB1 …

Tabulated Surface tool.

surftab1 ↵

Simply typing the name of an internal variable initiates a
command to change that variable … note that the default
value shown in parentheses is always its current value …

15 ↵

Set the value to 15 … that will give us a fairly good column!

[Surfaces.
Tabulated
Surface]

Issue the command and simply pick first the circle (path)
and then the vertical line (direction vector). Notice how the
railing butts into the column … AutoCAD provides no easy
tools to clean up those joints between surface objects.

The next step is to make this unit into a block …
[Draw.
Make Block]

Issue the Make Block command … name the block
“Column” … then click the buttons to set the insertion point
(use the |QUAdrant| snap mode and click on the large
circle near the base of the column) and to select the
objects (pick the column and both handrails and then press
↵). Finally, select the Delete option (we could use the
“Convert to Block” option, but I want you to go through the
exercise of inserting the block this time!).

[Draw.
Insert Block]

Issue the Insert Block command — in the dialogue box,
select Column and the option to specify the Insertion Point
on the screen — set all scale factors to 1and the rotation to
0 before clicking OK — use |QUAdrant| to locate the
Insertion Point for the block.

[Modify.Array]

Issue the Array Copy command — select the block just
inserted and press ↵ …

p↵

Select the Polar option.

0,0 ↵

Specify the Centre Point of the Array at the current UCS
origin …

20 ↵

Number of Items (this is the total number including the
original!) …

↵

Accept default value for Angle to Fill (ie. 360) …

y↵

Yes, rotate each copy!

Block Tools (Draw toolbar) …
Notice that the two buttons are the
same except that the one at the top
has a “page” behind it — that one is
the Insert Block command — the
other is the Make Block command
(to create a new block) …

Array command in the Modify
toolbar …

We now have 20 copies of the column block arrayed around the perimeter of the
platform, each of which will be an instance of that block, rather than a full copy.
If we had left out the “block / insert” phase of that procedure, then we would
have 20 copies … it would look the same, but very much less efficient.
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The last step in this section of the tutorial is to draw the roof canopy. Figure 16
shows how I set up mine with the PlatformColumns layer turned off. Once I get
you started, you can make your roof any shape you wish …
• Begin by creating a new layer called Roof and make it the Current Layer.
• Move the UCS up 2700 in the Z-direction, then rotate it about the X-axis so
that the X-axis is horizontal and the Y-axis is vertical.
• Select “plan view” … this will actually be an elevation view because we have
rotated the UCS.
• Then, draw a profile for your canopy roof, making sure that you provide some
kind of bulkhead that sits on the perimeter columns. (Hint: remember that
the columns have a diameter of 200 and create construction lines as
necessary to ensure that the peak of your roof lies exactly above the centre
of the tower.)

Figure 16

• Set SURFTAB1 to 20 so that the facets line up with the columns.
• Once you have created your profile, revolve it around the vertical axis
through 360 degrees.

CONSTRUCTING THE STAIR HANDRAIL
Discussion …

We construct the handrail as surface objects for the same reason that we gave
for the columns on the tower platform. In this case, however, we encounter
again some complications that result from the decision to taper the tower.
These are by no means insurmountable, but it did take me several false starts
before I discovered an efficient (??) way of doing it accurately. I’ll be interested
to hear from anyone who can suggest any improvements to the following
process!
When you analyse the taper problem with respect to the stair handrail, you
realise that each flight of stairs is the same length and height (because the
going and riser doesn’t change), but as you move higher up the tower, the
landings become smaller and their plan shape changes slightly. To
accommodate this, we will construct the handrail in two parts (illustrated in
Figure 17 over the page, including blow-up views of the joints), one for the stair
flight and an upstand element to be positioned at the outside corner of each
landing. These handrail elements are designed with “open ends” so that they
can be joined up “on site” with lengths of tube (we will use the Tabulated
Surface command to achieve those connections), which vary at every landing.
As we did on the tower platform, we will construct these handrails as blocks that
can be simply inserted at the appropriate position on each flight or landing.

Fillet
Fillet

Figure 18
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We again begin by drawing some construction lines. You should freeze every
layer except for Stair and Construction, making the latter the Current Layer.
You should also, at this point, create a new layer called Handrail. Set the UCS
back to World and select a plan view, zooming in on a convenient area of empty
“ground”. We will draw the profile of the flight handrail first, flat on the ground
(like we did with the stair), then rotate it up in to an upright position when we
need to. Note that the handrail should be 760 above the nosing of the stair, and
900 high on the landings. The height from the top of the first step to the landing
is 980 and the flight length (nosing to nosing) is 1960. Go through the following
steps, using lines only (no polylines):
• Draw a line using the following sequence of coordinates (starting at the lower
right of your screen): @500<180
@760<90
@-1960,980
@760<270
@1000<180
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Figure 17 Handrail Components and Details.
2 circles, either
end of the small
fillet arc.

• Now take the first line in that sequence and move it up 760 in the Y-direction.
• Take the last line in the sequence and move it up 900 in the Y-direction —
your drawing will now look like Figure 18.
• Set the Fillet radius to 40 and then fillet the lines indicated in Figure 18.
• Use 3D Rotate to stand the handrail up (exactly the same as we did with the
stair!).

1 circle, at the
outer end of the
small fillet arc.

• Set up a circle with radius 20 at each of the 5 positions indicated on Figure
19 — the two at the base of the vertical supports are easy — the others will
require you to set up the UCS using the ZAxis option on each of the 3
straight line segments so that the circle is correctly orientated.
• Set the UCS back to “world” and make Handrail the Current Layer.
• Set SURFTAB1 back to 6.
• Use the Tabulated Surface command to create the two posts and the long
railing between the posts.
• Make Construction the Current Layer again and turn off Handrail.
• Zoom in on one of the two fillet arcs (at either end of the long rail). We are
going to construct an axis line so that we can then use the Revolved Surface
tool to create the bends in the railing. Construct one line, beginning from the
|CENtre| of one of the fillet arc and extending to @0,–500,0 — repeat that
step at the other end of the long rail.

Figure 19

• Set the Current Layer to Handrail, and use the Revolved Surface command
to create the curved sections of handrail, first picking the circle at the end of
the curve (known as the path) and then picking the axis at the end nearest
the arc — the Starting Angle will be 0 in both cases — the End Angle will
-1
probably be 26.56 [ie. Tan (140/280)] for the “top end” of the handrail and
–26.56 at the “low end” — if the surface is drawn in the wrong direction, undo
and repeat the process using the opposite angle!
The next step is to convert this handrail element into a block. We must first reposition and rotate the UCS so that the block is defined with a convenient
orientation for later insertion onto the stairs. We are also going to store this as a
“nested block”: we will first create a block consisting of just the handrail itself
(calling that “FlightRail”); we will then create a second block made up from the
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block FlightRail plus the two construction circles that were created at the open
ends of this handrail (calling this “FlightMaster”). That way, we can insert
FlightMaster onto the stair, explode it so that we then have the block FlightRail
in place, plus the two construction circles that we will use to form the rails on
each landing. To do that, follow these steps:
• Zoom in on the base of the lower end of the handrail.
• Issue the UCS command, select the Rotate about Z option (to rotate around
the Z-axis), setting the rotation angle to 90.
• Re-issue the UCS command, this time using the Origin option — use the
From object snap to position the UCS origin at the point @–25,–25 relative to
the centre of the base of the handrail (this will be the Insertion Point for this
block and will correspond to the outside corner of the bottom tread of each
stair flight).
• Issue the Block command, name the block FlightRail, specify the Insertion
Point (as 0,0), then select the five tubular elements that make up the rail.
• Now Insert that block at the position 0,0 and accept the default X-scale, Yscale and Rotation settings.
• Issue the Block command again, this time naming the block FlightMaster,
setting the Insertion Point at 0,0 again, but this time selecting the block
FlightRail plus the two circles (on the Construction layer) that we created at
the two open ends of the handrail.

#

$
Figure 20
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Figure 21

Set the UCS back to “world” and zoom in on the bottom tread of the stairs.
Using Figure 20 as a guide, insert the block FlightMaster, positioning it at the
outer top corner of that tread 1 , accepting the default scale factors, but picking
point 2 when prompted for the rotation. If you zoom in on the top of the flight,
you will notice that the top upstand of this handrail is not positioned correctly on
the first landing! This is because of the 1:70 taper: the landing is offset by
some 18 mm relative to the bottom step. The solution to this is simple: first, we
will rotate this block around its insertion point to get it to the right position; then
we will explode it and re-create the block in that rotated state so that we can
insert it correctly on each flight. To do that, follow this procedure:
• Using Figure 21 as a guide, issue the 2D-Rotate command, select the
inserted handrail, and, when prompted for the Base Point, use the .xy filter of
the block’s Insertion Point (plus a point on the current UCS as the Z-value) to
indicate the centre of rotation (this is point 1 in Figure 21).
• When prompted for the Angle, type r ↵ (for “Reference”), and then use the
.xy filter again to pick 1 , then, with ORTHO on, pick any point in the negativeX direction as the second point (say point 2 in Figure 21), and finally use the
.xy filter and |ENDpoint| and pick point 3 (followed by any point on the UCS
plane to provide the Z-value) to yield point 4 .
• The handrail should now be properly positioned. Position the UCS on the top
face of the bottom step with the origin at 5 , the X-axis through 6 , and the YPLANE through 7 .
• Explode the FightMaster block.
• Now re-create the FlightMaster block with the Insertion Point at 0,0 and
selecting the rotated block and the two circles on the Construction layer.
• Finally, insert that new block on the bottom flight in the same way we did
before (as per Figure 20) — is it correctly positioned this time?

"
!

The next step is to construct the upstand element that will sit on the outer corner
of the landing. Zoom in on the first landing, setting up a view like Figure 22. We
will first set up the construction lines shown in that figure …

$
%
Figure 22
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• Set the Current Layer to Construction, and use the UCS command with the
3point option to position the Origin at 1 , the X-axis at 2 and the point on the
XY plane at 3 .
• Beginning at 1 , construct a line to @0,0,-900.
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• Also beginning at 1 , construct two separate lines that terminate using the
|NEArest| snap mode at roughly the positions 4 and 5 respectively (the length
of these lines is not important).
• Offset those last two lines by 25 mm as shown (you will need to turn off the
Stair layer temporarily for this and the next couple of steps!).
• Construct a 20 radius circle, centred at the intersection of the two offset lines
— you should now have all the lines shown in Figure 22! Erase the two
lines that intersect at the centre of the circle.
• Now move the three lines that converge on 1 so that the bottom point of the
900 long “vertical” line is positioned at the centre of the circle just created.

#
"
$
Figure 23

• Zoom in on the top of that re-positioned vertical line and use the Fillet
command (still with radius 40) to construct a fillet arc between the two
horizontal lines that converge at 1 in Figure 23 — now reset the fillet radius
back to 0 since we won’t need that again!
• Construct an axis line beginning at the centre of the fillet arc just created and
extending up @0,0,100.
• Now re-position the UCS using the ZAxis option so that you can construct the
circle at 2 with radius 20 — then repeat that process to construct the 20
radius circle at 3 .
• Zoom out a bit and set the UCS back to the top of the landing as it was at the
start of this sequence. Turn on the Stair layer again.
• Set the Current Layer to Handrail and create the two handrail components
using a Tabulated Surface and a Revolved Surface (using an Included Angle
of 51.43 degrees, ie. 360/7).
That completes the upstand component of the handrail. You are now to follow
the same procedure as with FlightRail to create a nested block (calling it
“UpstandMaster”) consisting a block called “Upstand” plus the two construction
circles positioned at the open ends of the curved horizontal rail. Note that with
the current UCS, the Insertion Point would be 0,0.
Once you have done that, set the UCS back to “world” and erase the
construction lines used to create the handrail. Then set the Current Layer to
Handrail and execute the following procedure for each stair landing all the way
up the tower:

This process is rather tedious
because it has to be repeated
about 16 times!

• Insert both blocks UpstandMaster and FlightMaster in the appropriate
positions on the landing, using |ENDpoint| to accurately set the insertion point
and rotation of each block.

You will find it fairly quick once you
get into it … you may even find a
few shortcuts … for example, I
found that selecting the Explode
option in the Insert Block dialogue
made things quicker …

• Explode both blocks ONCE.
• Turn off the Handrail layer and set the Current Layer to Construction.
• Use the |CENtre| snap mode to construct two lines between the centre points
of the circles that have to be connected up with a handrail tube.
• Set the Handrail layer as the Current Layer even though it is turned off —
AutoCAD will warn you that you have done that … simply click the OK
button! We do this so that we can see the construction lines & circles that
we are going to join up to complete the rail.
• Use the Tabulated Surface command (on the Surfaces toolbar) to construct
each of the two lengths of handrail, picking the corresponding construction
circles & lines — the new rails will not appear because the Current Layer
(Handrail) is invisible, but they will be created!
• TURN ON the Handrail layer again to check that the new rails were created
successfully. (Hint: if the tabulated surface was constructed in the wrong
direction, undo it and generate the surface from the circle at the other end of
the line.)
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• Use Realtime Zoom to move between landings … there should be no need to
rotate your view, provided you can see all the points that you need to carry
out this procedure at each level.
This step will test your skills at
creating extruded pipework on your
own!

When you have inserted all the rails, you will find that the top one is too long
because the top flight of stairs on to the platform is shorter. All you need to do is
turn on the Platform layer (so you can see what you are doing!), explode the
FlightMaster block, re-position the upstand element, and replace the straight rail.
That should complete the handrail.

SHADING CANOPIES OVER THE STAIR LANDINGS
We now have one last touch to add to our model. Conscious that our Monks
have to carry heavy burdens up this long winding stair, I have stretched out a
piece of shadecloth over every third landing — who said a monk’s life was all
discomfort! This simple element will introduce you to a couple of useful tricks.
Begin by creating a new layer called “ShadeCloth”, freezing all layers except
Stair, Construction and ShadeCloth, and setting Construction as the Current
Layer. Then, zoom in on a view of the third landing from the bottom similar to
that shown in Figure 24. Follow these steps:

#
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• Construct four vertical construction lines 3000 long at the points marked 1 , 2 ,
3 & 4 — the last two points are 50 mm below the bottom of the step.
• Position the UCS so that the Origin is at 4 and the X-axis follows the direction
of the outside edge of the landing (do this in two steps: use the 3point option
to set up the UCS on the landing, then move the origin to 4 )— use 3DRotate
to rotate the line 30 degrees away from the landing — repeat this process for
the line that starts at 3 , this time with the Y-axis following the edge of the
landing.

"
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Figure 24

• Position the UCS so that the Origin lies at 3 (Figure 24) and the Z-axis runs
up the (now sloping) line — construct a 10 mm radius circle centred at 3
(which we will extrude later to form a pole to support the tarpaulin) — do the
same at point 4 .
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• Now, turn off the Stair layer, set the Current Layer to ShadeCloth and use
Figure 25 as a guide to position the UCS with the Origin at 1 , the X-axis
passing through 2 , and with 3 representing a point on the positive-Y portion
of the XY plane — use Draw > Arc > Start, End, Direction (from the pull down
menus) to construct arcs between 1 & 2 and 1 & 3 , being careful to use
|ENDpoint| to lock accurately to those points, and judging the curvature of the
arcs by eye.
• Repeat the last step with the UCS origin at 4 , constructing arcs 4 - 3 and 4 - 2 .

Figure 25

• Use the Edge Surface command to construct the surface mesh picking the 4
arcs just created — if AutoCAD says that the four edges don’t touch, it is
because you did not set the UCS and use |ENDpoint| snapping to construct
the arcs.

Edge Surface tool

• Now use the Tabulated Surface command to construct the poles.
• Next, create a new layer called HideMesh and move the surface mesh (only)
to that layer — later we can turn off that layer so that the mesh is invisible but
still makes our shadecloth tarpaulin opaque when the hidden lines are
removed.

"
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Figure 26
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• Finally, turn ON the Stair layer and turn OFF the Construction layer, then use
Figure 26 to position the UCS with Origin at 1 , X-axis through 2 and XY
plane through 3 — make the two poles, four arcs and the mesh into a block
called Tarp, and with the Current Layer set to ShadeCloth, insert that block
on every third landing (except the one just below the platform).
ALL DONE!!
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